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HOW TO WRITE A SCIENTIFIC LABORATORY REPORT  

IN APA FORMAT  
 

NEVER USE THE APA TEMPLATE IN MS WORD!  If you do and once you 

save the document, you will not be able to go back and make certain corrections.  For 

example, if you did not indent paragraphs and then try to correct it, the template will only 

right justify the document.  You will not be able to move tables or graphs.  In addition, 

you will not be able to use hanging indentation.  Start with a Word Blank document and 

you’ll have no problems editing. 

The purpose of a lab report (or scientific paper) is to provide background information 

and other research performed on the topic.  In addition, it gives information about the 

experiment, how it was conducted, what results were found and any conclusions made 

based on those results.  It also provides information so that someone else (another 

researcher or even a layperson) can replicate (repeat) your experiment and get similar 

or the same results!   

If you read and follow this handout completely and honestly, you should get a 

good grade on your lab report. 

 

 

Scientific lab reports are always written in APA Writing Style format (American 

Psychological Association).    This document will guide you through the APA format and 

will illustrate the APA citation style.  The last two pages of this handout are step-by-step 

directions on how to create a table and graph using MS Excel 2013/2016. 

 

GENERAL FORMAT OF AN APA PAPER 

Scientific laboratory reports or any other APA style paper written at a collegiate level 

have a standard format.   It is best to first check with your instructor to verify the format.  

Some instructors may want something a little different.  The following are standard for 

APA papers: 

 1 inch margins on all sides 

 12-point font and the font style should be either Calibri, Arial, or Times Roman 

 Some type of Header (Running Head:) 

 Numbered pages except the Title Page 

 Paragraphs indented 5 spaces 

 DOUBLE-SPACED throughout the paper including Title Page and Reference 

Page. 
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Scientific laboratory reports have a separate Title Page and a separate Reference page.  

Some instructors want an Abstract as well but check with your instructor first.   

Unlike other types of papers or reports, scientific reports have HEADINGS within the 

body of the paper.  These headings are: 

 Introduction 

 Methods & Materials 

 Results 

 Discussion 

TITLE PAGE 

The first page of the lab report is the TITLE page.  Do NOT number the Title page 

unless instructed to do so. 

The title of the lab report should NOT be too general but should reflect more specifically 
about the experiment.  For example: “Fingerprinting” is too general for the title but 
instead, use something like: “Fingerprinting as an Effective Forensic Tool in Solving 
Murders.”  The title should be informative; it should not be “cute.” 

Some lab instructors may want what’s called a “Running Head” but some do not.  
Check with your instructor first.  When adding the page number in the header area 
(Insert Tab – Header/Footer or right click the mouse at the top of the page then click on 
Edit Header) of the report, also include the Running Head.  Insert the page number first 
then make sure the cursor is in front of the number then type the Running Head.  The 
Running Head should appear as Running Head:  SHORT TITLE OF PAPER IN ALL 
CAPS (but not in bold).  After typing the running head, press the tab button until the 
running head is flush left and the page number is flush right in the header area.  Close 
the Header/Footer editing tab.  

NOTE:  The title is in Title case (first letter of each word is capitalized except non-
essential words.)!   

The Title page information should be absolute centered on the page. 

The Title page should NOT be numbered! (unless instructed) 

NO PAGE NUMBER ON THE TITLE PAGE 

To eliminate the page number on the title page: 

 Place mouse arrow at top of page and right click 

 Click on Edit Header 

 Click insert page number (top of page, plain #3) then type Running Head: and 
tab so that running head on left and page number on right 

 While in the Edit Header Tools, in Options check Different First Page  

 Go back to Page Number and click the small black arrow. 

 Select Format Page Number 

 Click on Start At: then put zero (0) in white box. 
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 The Running Head will disappear on the Title page so type it again. 

 The next page of your document should have both the running head and page # 
1. 

 Close the Edit Header/Footer Tool bar 

Usually start the title 10 line spaces down from the top margin.   If required a Running 
Head, it should be in the upper left corner of the Header area (above the top margin of 
the page).  The Title page must be doubled-spaced and include the following 
information: 

 

 

Title  

Your Name (author) 

Names of those in the experimental group (do not put “Group Members” next to names) 

Name of Institution/Instructor 

Class name and section 

Date 

 

 

Title Page – can you honestly check off the following? 

Did you?: 

 State the Title and Center on the page? 

 State your name?  

 State the names of other group members that participated in the experiment with 

you? 

 State the Institution and the Instructors’ name? 

 State the Date? 

 NOT number the page? 

 Give a title that summarized the main idea of the experiment? 
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Fingerprinting as an Effective Forensic Tool in Solving Murders 

Joe College 

Jane College, Harry Potter, Norman Rockwell and Barry Allen 

Georgia State University Perimeter College 

Dr. Jane Science 

Biology 1401 330 

January 15, 2015 

 

 

 

 

 

 

**** Example Title page.  Title case and absolute centered on page.  The 

Title summarizes the main idea of the experiment. 
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Fingerprinting as an Effective Forensic Tool in Solving Murders  
(restate Title from Title page) 

Introduction (Heading should be flush left and double-spaced below Title).  The header 

“Introduction” should NOT be bolded, capitalized, in quotations or underlined. 

The Introduction does just that:  INTRODUCES the topic or concept on which an 

experiment was performed.  It is in the Introduction where you explain the ideas or 

concepts and NOT the experiment. 

The paper must be written in THIRD person.  Do NOT use I, me, we, them, they, he, 
she or us. 

Explain why the topic is important and if needed, a short history.  How does the topic 
relate to other previous work that is similar to your experiment?  What other research 
has been done on this topic?  

ALL resources (references) MUST be properly CITED in the Introduction.  For 
example:  According to Lee (1997), the forensic use of fingerprinting has assisted in the 
prosecution of thousands of perpetrators of crime.  Or, “The first use of fingerprinting in 
a crime investigation was in 1889 by Sherlock Holmes (Aldin, 2001).”    

Credit must be given to other author’s words, ideas and thoughts whether directly 
quoting (using quote marks) or paraphrasing.  It is considered PLAGIARISM if credit is 
not given. 

Do NOT continuously quote material (one quote after another throughout the 
Introduction) from your references because you are unsure how to paraphrase.   

 

 

In the Introduction, NEVER: 

 Discuss results 

 Write in first person 

 Include information just to fill in space. 

 State how data were collected (data are plural!) 

 Use numerous quotes instead of paraphrasing.  But, avoid paraphrasing that 
isn’t written in your own words! 

 Plagiarize literature reviews or anything else in the paper (use quotations if 
directly quoting otherwise paraphrase or use your own words) 

 Use direct information from the lab manual or lecture book 

 Start the Introduction with “In this experiment…”  or “We experimented on….” 

 Include unnecessary information.  “A Sharpie was used…” 

 Be wordy! 

 Triple space between paragraphs or next Heading 

 Start the Hypothesis with “I hypothesize… or “My group hypothesizes…” or 
anything else that is first person.” 
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The last paragraph in the Introduction is for stating the Purpose and Hypothesis.   

The Purpose is stating why the experiment was performed.  Do NOT make statements 
such as: “The purpose of this experiment is to learn more about solutions.”  Or, “The 
experiment will help me learn more about fingerprinting.”  Or better yet, “It’s part of my 
grade.”  The purpose should be logical and scientific.  Basically, what was the lesson 
learned! 

It is also in the Introduction where your HYPOTHESIS (ES) is stated.  A hypothesis is a 
scientific guess of the outcome of the experiment.   NEVER start the Hypothesis with “I 
(or We or Our group) hypothesize ….”  It should still be stated in Third person.  For 
example: “It is hypothesized that comparing fingerprints from the crime scene with 
those….”   The hypothesis is usually in the form of “If … then.” 

The hypothesis is always created PRIOR to doing the experiment.  What outcome 
or outcomes do you expect from doing the experiment? 

The Hypothesis MUST be relevant to the experiment that will be performed.  You can 
only create a hypothesis about the experiment.   The hypothesis should be formulated 
BEFORE you do the experiment.  If you wait until after writing the paper to state a 
hypothesis, you will find that you may have to waste a lot of time re-writing the paper to 
fit the hypothesis. 

Introduction 

DID YOU? 

 Write in third person 

 Give appropriate background about the topic or concept related to the 
experiment and not the experiment itself 

 Properly In-Text Cite references  

 Use quotations when directly stating from reference 

 Did not quote everything but used paraphrasing or own words 

 Restate the title at the top of the first page before starting the Introduction 

 Place the Introduction Heading flush left 

 State Purpose of experiment 

 State Hypothesis 

 Number page 

 Plagiarize (DON’T DO IT) 

 Spell words correctly and used proper grammar (MS Word has a Spell Check 
and Grammar check – Use it!) 

 Use proper spacing, standard font size (12 pt.) and type face.  
 

Methods and Materials  

This section is used to describe HOW the experiment was performed.  There should be 
enough information so that another researcher or layperson can repeat the experiment 
and get the same or similar results.  This section is written in sentence (narrative) 
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format DESCRIBING the materials and/or equipment used and EXPLAINING the steps 
taken to collect data. 

You should NEVER just LIST materials used and steps taken.  These should always be 
explained in a narrative, sentence format.   

DO NOT LIST!!!  Do not plagiarize information from the lab manual or experiment 
handout! 

The M&M section should always be written in PAST TENSE since you have already 
completed the experiment.  Remember that you are describing what you did or how 
you set up the equipment so that data were collected and what materials were used. 
However, you must include enough detail that another person could set up the 
experiment the same way you did! 

Do not include unnecessary information such as:  “A blue sharpie pen was used to 
label….” Or “Three marks were made on test tube #1…”  Use statements such as: 
“Three mls of water and 3mls of methylene blue were added to each of three test tubes 
marked 1-3.”  

Variables of the experiment should also be described in the M&M section.  Both 
Dependent and Independent variables are explained.  What were the Dependent 
variables and the Independent variables?  One or more variables were manipulated 
(independent) while other variables (dependent) have changed based on what was 
done to the independent variable(s). 

Do NOT make any statements about the data collected.  This will be in the Results 
section. 

 

Methods and Materials 

DID YOU? 

 Write in Past Tense 

 NOT list materials or steps taken to collect data 

 Not state the same that is in the lab manual (use your words only) 

 Describe in sentence format any materials and equipment used 

 Describe the steps taken to collect data  

 Describe variables (dependent and independent) 

 Take care not to describe the results or make opinionated statements about the 
results (save that for Discussion!) 

 Make it so another researcher or layperson can repeat your experiment 
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Results   

This section is for PRESENTING the data that were collected in the experiment.  DATA 
ARE PLURAL!  Your presentation of the data should allow readers to draw some type of 
conclusion about your experiment. 

You MUST include Tables and Figures (graphs) in this section about the data you 
collected.  All tables and figures should be described in NARRATIVE format. 

You MUST describe the data in a narrative form and not just insert a table or graph or 
some type of listing.  Follow the sentence descriptive form as with any section of the lab 
report except you will also insert a table(s) and figure(s) displaying the mathematical 
data. 

You should NEVER DISCUSS what the data MEAN in this section. 

Other readers should be able to easily read and understand what was measured from 
the table and figure. 

TABLES AND FIGURES MUST BE NUMBERED and have an informative title.  The 
number and title are placed ABOVE the Table or Figure and double-spaced.  The 
information inside the table is not double-spaced. 

For Example: 

Table 1.   

Weight changes (gms) for nuts placed in various percent NaCl solutions versus time in 
minutes 

Time 
0% 

NaCl 
10% 
NaCl 

20% 
NaCl 

40% 
NaCl 

0 1.2 1.9 2.9 3 

15 2.4 3.1 4.3 4 

30 3.6 4.5 6.9 5 

45 7.1 7.5 8.8 6 

60 10 12 11.1 7 

 

Figures are also numbered and can include Graphs, Charts and Illustrations 

Figures (Graphs, Charts and Illustrations) must have Legends, Specific Titles, X & Y 
axes named, numbered and a short explanation of the figure.   

The titles on the X and Y axes should also include the type of measurement such as 
gms (grams), min (minutes), cms (centimeters), etc…  The measurement types can be 
abbreviated. 
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The figure number and title are placed above the figure and double-spaced. 

For example:  

Figure 1.   

Weight (gm) changes of Nuts in NaCl solutions (%) versus time (min). 

 

 

 

Results 

DID YOU? 

 Use narrative format to describe data 

 Insert Table 

 Insert Figures (Graphs, Charts and Illustrations) 

 Label and number Table and Figure appropriately 

 Give descriptive title to table and graph 

 Include Legend for graph 

 Use appropriate units of measurements (gm – grams; min – minutes; hr –hours; 

spell out or use correct abbreviations) 

 NOT discuss meaning of results but instead just described the data collected 
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Discussion    

In this section, you will EXPLAIN or analyze the results.  The hypothesis(es) should be 

restated.  Your conclusions should be well organized and thoughts not scattered about 

in different paragraphs.  You can also in-text cite references again in the discussion to 

support your thoughts.   

In this section, your results are INTERPRETED!  Why are the results the way they are?   

Are the data similar to previous experiments?  INTERPRET!  Were your group results 

similar to other groups?  Why or why not?   

Include a short discussion as to whether the data SUPPORTED or did NOT SUPPORT 

your hypothesis.  A hypothesis cannot be Right or Wrong!  It cannot be correct or not 

correct or good or bad.  A hypothesis can ONLY be supported or not supported by the 

data collected.  Do not make statements in your discussion such as “The results 

showed that my hypothesis was right (or wrong).”  There is no right or wrong!   

If your hypothesis is not supported by the data, it does not necessarily mean that you 

did something wrong.  You may have not done the experiment correctly but more than 

likely, there were other factors that may have altered the outcome such as 

contaminated solutions or instruments not properly calibrated or whatever you may think 

went wrong.      

Assumptions about any possible ERRORS while collecting data should be discussed.  

Refer to the data to support your speculations about the experiment.  Do not state that 

“something went wrong” or “I was not clear about the instructions.”   Compare your 

group data to those of other groups to see if your data are similar to the other groups. 

The last paragraph should state the major findings of the experiment/study. 

Discussion 

DID YOU? 

 Restate Hypothesis and conclude if supported or not 

 Interpret results 

 Make speculations about the study 

 State major findings in last paragraph 

 If needed, cite references again 

 State conclusions about the experiment 

 State any errors in the experiment 

 Organize conclusions 
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Clinical Applications (ONLY for Anatomy & Physiology lab reports) 
 
In this section, you should briefly state any generalizations that you can draw from the 
experiment and its’ relevance to the natural processes in the human body.  Why is the 
topic important or what is the relevance of the topic in the medical field?   
 
In-text citations are encouraged but check with your instructor first to see if required.   
 
You do NOT restate information from the Introduction, Results or Discussion. 
 

 

References 

References are the scientific/scholarly articles from VALID and RELIABLE sources 

about similar studies.    

NEVER use WIKIPEDIA as a reference.  It is NOT valid or reliable!! 

References for Scientific papers should be listed in APA (American Psychological 

Association Writing Journal) format.     

Once again, you should NEVER use Wikipedia as a reference.    

The best way to gather your references is to do a GALILEO search first.  Other reliable 

web sites include WebMD.com, CDC.gov, nih.gov, or nih.gov/pubmed.   

There are other reliable resources on the internet but be cautious.   

Reliable and valid resources include: 

 An author(s)  

 Publication date  

 Affiliation with company or institution  

 Some type of contact information   

 Preferred peer reviewed.    

The Reference Heading should be centered at the top of the page.  The heading 

should NOT be in bold, italicized or underlined.  References are never bulleted or 

numbered.   

References should be listed on a separate page and in alphabetical order. 

Use the following format: 

Basic Format for List of references at the End of the Lab Report 

APA style dictates that authors are listed last name first followed by first name initials; 
publication year goes between parentheses, followed by a period. The title of the article 
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is in sentence-case, meaning only the first word and proper nouns in the title are 
capitalized. The periodical or journal title is italicized and in title case (first letter of each 
word is capitalized except non-essential words such as in, of, a, and, etc…), and is 
followed by the volume number which, with the title, is also italicized.  If there is an issue 
number, it is in parentheses next to the volume number and is not italicized.  Page 
numbers are in the format xx-xxx.   

If the article was retrieved from the internet, include the URL.  It should be written as 
Retrieved from then the web address.   

Author, A. A., Author, B. B., & Author, C. C. (Year). Title of article. Title of Periodical, 

volume number (issue number not italicized), pages. Retrieved from 

http://www.xxxx.xxxx.   

Articles from GALILEO Database 

If the articled was retrieved from GALILEO, a URL is not needed.  Articles from 
GALILEO should include the Database in which the article was found and listed after 
the page numbers.   

Author, A. A., Author, B. B., & Author, C. C. (Year). Title of article. Title of Periodical, 

volume number (issue number not italicized), pages, Academic Search 

Complete. 

Additional information on how to properly list references can be found on the LTC web 

site under Handouts then Reading/Writing Handouts, APA Reference Types.  

http://www.depts.gpc.edu/~gpcltc    

References 

DID YOU? 

 NOT use Wikipedia as a reference 

 List references in proper APA format 

 Center Heading 

 Use separate page 

 Select articles from valid and reliable scientific journals (usually peer reviewed) 

 NOT just list a web address 

 Provide all information for the reference (author, pub. date …) 

  

http://www.xxxx.xxxx/
http://www.depts.gpc.edu/~gpcltc
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Creating Tables and Figures (Charts) in Excel 

If using a computer on campus such as in the computer labs or the LTC:  From the 

desktop, double click on the Microsoft Office 2013 icon.  Double click on the Excel 

program to open. 

Follow these steps to create tables and charts in Excel then copy and paste into your 

lab report document in the Results section. 

1. Open Exel 

2. Click one time on Blank Worksheet to open a new worksheet for your data. 

3. Enter your Data into the Cells.  The first row and column should be used for your 

Headings such as Time, % solutions, weight etc…  The second row is for data 

entry. 

4. SAVE! 

5. Once all data have been inserted into the table (SAVE!), place the mouse arrow 

on the first cell (usually A1) then click and hold the mouse button to highlight the 

entire Table. 

6. From the tab bar at the top, click on Page Layout tab. 

7. From the drop down window of the Page Layout tab, select Set Print Area.  

SAVE! 

8. A small icon will appear at the lower right corner of the table.  Click one time on 

the icon. 

9. If the icon does not appear, place the mouse arrow somewhere over the Table 

then right click the mouse and select Quick Analysis. 

10. Select Charts from the Quick Analysis then choose the Type of chart.  Most lab 

instructors prefer a Line chart but check with your lab instructor first. 

11. The chart will appear to the right of the table. 

12. SAVE! 

13. To the right of the chart will be several icons.  Click on the icon that looks like a 

plus sign.  A list of chart elements will appear. 

14. Make sure Legend and Axis Titles have been checked along with the ones 

checked by default. 

15. SAVE! 

16. In the chart, click on the Chart Title and type in the name of the chart.  It does not 

need a number in the actual chart area but it does need to be specific and not 

general. 

17. Click on the Axis titles and give a name for each axis (i.e. Weigh, time…).  Make 

sure to include the measure such as time in minutes (min.) or weight in 

grams (gm)…. 

18. SAVE! 

19. It is best to put grid lines and borders on tables. 

20. From the Home tab and to the right of the Underline icon, click on the small black 

arrow next to the border icon. 
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21. Select All Borders in the drop down window. 

22. Once finished SAVE! 

23. To place the table and chart into your Word document.  Minimize your Word 

document. 

24. In Excel, highlight the table then right mouse click then select COPY from the 

drop down window. 

25. Got back you the Word document and mouse click where the Table will be 

inserted. 

26. Select Paste from the Home tab menu. 

27. Below the Table, number and label.  See the Results area for an example of 

numbering and labeling a Table. 

28. Repeat these steps for the Chart and see the Results area for an example of 

numbering and labeling a chart. 

29. SAVE!!!!!!!! 

30. You may want to save the Table and Chart you created in Excel just in case 

things go wrong! 

 

Hanging Indentations for References 

Remember that References are on a separate page.  The Reference title should be 

centered at the top margin. 

1. Type the references  

2. Make sure the references are alphabetized 

3. Highlight all References 

4. Under the Home tab, click on the spacing icon then select 2.0 for double spacing 

5. While Highlighted and on the Home tab, click on the small black arrow next to 

Paragraph in the paragraph section. 

6. A pop up window will appear 

7. Under the Indentation section in the pop up window, go to Special and click on 

the black arrow. 

8. Select Hanging. 

 

Additional Help 

A shortened sample of a lab report can be found on the LTC home page under Decatur 

Workshops.  The Workshops link is on the left side of the page with all other links. 

If you are unfamiliar with MS Word or Excel, a handout on the basics of MS Word and 

Excel can be found under Decatur campus Workshops on the LTC home page. 

Additional APA Writing Style information can be found at the Purdue Online Writing Lab 

(OWL). 

https://owl.english.purdue.edu/owl/
https://owl.english.purdue.edu/owl/

